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[bookmark: _Toc499721120]Introduction
Intended Audience
[bookmark: _Toc499721121]This document is intended to help local education agencies (LEAs) quickly become familiar with how to use the Principal Apportionment Data Collection (PADC) Software. Understanding basic Windows functions and procedures, such as clicking, double clicking, right clicking, browsing, etc., will assist you in using this document and software.
Related Documents
For step-by-step installation instructions, please refer to the Principal Apportionment Data Collection Manual and Tax Software Installation Guide that accompanies this User Guide and is available on the California Department of Education (CDE) Web page at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp.
For more information on how to report data using the software, please refer to the Data Reporting Instruction Manual (DRIM) located on the CDE Principal Apportionment Data Collection Web page at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp. 
[bookmark: _Toc499721122]For more information on known software problems, please refer to the Known Problems, Fixes, and Workarounds Web page at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp.
System Requirements
[bookmark: _Toc21748252][bookmark: _Toc383409618][bookmark: _Toc401127911][bookmark: _Toc499721123]The installation of the software requires approximately 20–40 MB of hard disk space on Windows based PCs. 
Document Conventions
This document uses the following conventions to describe functions and procedures in the software: 
[bookmark: _Toc405462086][bookmark: _Toc405466248][bookmark: _Toc405469240][bookmark: _Toc405541609][bookmark: _Toc405541861][bookmark: _Toc405544844][bookmark: _Toc405545315][bookmark: _Toc405462087][bookmark: _Toc405466249][bookmark: _Toc405469241][bookmark: _Toc405541610][bookmark: _Toc405541862][bookmark: _Toc405544845][bookmark: _Toc405545316][bookmark: _Toc405462088][bookmark: _Toc405466250][bookmark: _Toc405469242][bookmark: _Toc405541611][bookmark: _Toc405541863][bookmark: _Toc405544846][bookmark: _Toc405545317][bookmark: _Toc405462089][bookmark: _Toc405466251][bookmark: _Toc405469243][bookmark: _Toc405541612][bookmark: _Toc405541864][bookmark: _Toc405544847][bookmark: _Toc405545318][bookmark: _Toc405462103][bookmark: _Toc405466265][bookmark: _Toc405469257][bookmark: _Toc405541626][bookmark: _Toc405541878][bookmark: _Toc405544861][bookmark: _Toc405545332][bookmark: _Toc405462104][bookmark: _Toc405466266][bookmark: _Toc405469258][bookmark: _Toc405541627][bookmark: _Toc405541879][bookmark: _Toc405544862][bookmark: _Toc405545333][bookmark: _Toc405462113][bookmark: _Toc405466275][bookmark: _Toc405469267][bookmark: _Toc405541636][bookmark: _Toc405541888][bookmark: _Toc405544871][bookmark: _Toc405545342][bookmark: _Toc405462132][bookmark: _Toc405466294][bookmark: _Toc405469286][bookmark: _Toc405541655][bookmark: _Toc405541907][bookmark: _Toc405544890][bookmark: _Toc405545361]Window Names
The names of windows, screens, and dialogue boxes use title case, such as: “Save As” window, “User Information” screen.
Commands
Commands are operations you must follow in order to perform certain functions in the software. Bold face font is used, such as: “Select Print from the File menu” and “Click the OK button”.
Image Names
Images, or pictures, are described as Figures and use Italic face font, such as: “Figure 1: Diagram of the data process”.
Important Notes
Notes include important statements regarding steps you may need to take. They are highlighted in gray, with a black border on the top and bottom, such as:
Note: Important note here
[bookmark: _Toc499721124]
Data Collection Software
The PADC Software is used by county offices of education (COEs), school districts, charter schools, and special education local plan areas (SELPAs) to:
Enter attendance data for COEs, school districts, and charter schools
Enter Local Control Funding Formula (LCFF) data
Enter tax data
Enter special education data
For detailed information on the data entry screens, refer to the DRIM available under the PADC Software Fiscal Year 2018–19 link at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp.
[bookmark: _Toc499721125]The following subsections describe step-by-step instructions for each LEA type (COE, school district, charter school, SELPA, and county auditor) to use as a guide to ensure the complete submission of Principal Apportionment data to the CDE. A table is also provided for each LEA type that lists all the data entry screens applicable to that LEA, a summary of the data collected in each screen, and the periods for which the entry screen is available. The remaining sections of this document provide a user with detailed instructions on how to accomplish the step-by-step instructions listed below.
COE Instructions
Each COE has local procedures that should be followed to accurately report data in time for each Principal Apportionment reporting deadline.
To report COE data or data for which the COE is responsible to report (school districts, charter schools, taxes, and SELPAs):
1. Install the PADC Software.
2. Add a county office user and login.
3. Select the correct reporting period.
4. Enter COE data in applicable entry screens.
5. Import certified school district files and verify their contents.
or
Enter school district data in applicable entry screens for every school district in the county.
6. Import certified charter school files and verify their contents.
or
Enter charter school data in applicable entry screens for every charter school in the county.
7. Import a certified tax file and verify its contents.
or
Enter school district and county tax data in applicable entry screens.
8. Import certified SELPA files and verify their contents. 
or
Enter SELPA data in applicable entry screens for each SELPA.
9. Ensure that all data exists for lower-level LEAs by running a Status report.
10. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.
11. Export the data for the COE, county auditor, school districts, charter schools, and SELPAs to a certified data file.
12. Upload the certified data files to the CDE utilizing the Upload Certified Data functionality.
13. Print and sign a COE certification page(s) and retain it for your records.
Optional tasks include:
1. Printing reports for each entry screen.
2. Exporting data to an ASCII file for use in other software.
3. Printing blank certifications or certification exception.
Data Collection and Tax Software Installation Guide, 2018–19 Fiscal Year California Department of Education, School Fiscal Services 5
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[bookmark: _Toc499721126]COE Entry Screens
Table 1 displays available entry screens, the type of data that needs to be entered, available reporting periods, and whether the entry screen allows for multiple records.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Adults in Correctional Facilities 
	Average daily attendance (ADA) and certification of LEA’s participation in the Adults in Correctional Facilities (AICF) program for the prior year.
	Yes
	Yes
	Yes
	Yes
	Yes
	No

	Attendance COE
	ADA for students that generate funding under the Alternative Education Grant [EC 2574(c)(4)(A) or (B)] and other miscellaneous categories.
	Yes
	Yes
	Yes
	Yes
	Yes
	No

	Attendance District Funded County Programs
	ADA reported by a COE by district of residence for students they serve that are not funded through the COE’s Alternative Education Grant. This ADA is credited to the district of residence and included in the district’s LCFF entitlement calculations. Additionally, a COE may enter up to two funding rates by grade span for each ADA category, by district of residence for the CDE to administer the transfer of funds between the district of residence and the COE, provided the district agrees to the transfer.
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes

	COE Audit Adjustments to CALPADS Data
	Enrollment and unduplicated pupil counts changes to a COE’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to CDE.
	No
	No
	Yes
	No
	Yes
	Yes

	Foster Youth Necessary Small High School
	Number of full-time teachers and ADA for a necessary small high school maintained by a COE for the exclusive purpose of educating foster youth pursuant to EC 42285(b)(2) for necessary small high school funding.
	Yes
	Yes
	Yes
	Yes
	Yes
	No

	SELPA ADA Allocation
	Allocation of SELPA ADA. By allocating the ADA in this entry screen, COEs can credit the ADA to SELPAs where special education services are provided.
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes


[bookmark: _Ref405378993][bookmark: _Toc499721069]Table 1: COE Entry Screens
Data Collection and Tax Software Installation Guide, 2018–19 Fiscal Year California Department of Education, School Fiscal Services 7
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[bookmark: _Toc499721127]Tax Entry Screens
Table 2 displays the entry screens available to users for the COE user group under the County Auditor LEA type. 
Note:	County Superintendents must submit Miscellaneous Funds information, even if the amount is zero.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Miscellaneous Funds
	Funds from royalties, bonuses, and payments in lieu of taxes.
	No
	No
	Yes
	No
	Yes
	Yes

	Special Education Tax Allocation
	Allocate a percentage of tax receipts to each SELPA Administrative Unit to which the COE belongs.
	Yes
	Yes
	Yes
	No
	Yes
	Yes

	Taxes
	School district and county taxes.
	Yes
	Yes
	Yes
	No
	Yes
	Yes


[bookmark: _Ref436812059][bookmark: _Toc499721070]Table 2: Tax Entry Screens
[bookmark: _Toc499721128]School District Instructions
Each school district has local procedures that should be followed to accurately report data in time for each Principal Apportionment reporting deadline.
To report the school district’s data or data for which the school district is responsible for:
1. Install the PADC Software.
2. Add a school district user and login.
3. Select the correct reporting period.
4. Enter school district data in applicable entry screens for the appropriate district.
or
Import a certified school district file and verify its contents.
5. For charter schools that the school district has authorized, enter charter school data in applicable entry screens for the appropriate charter.
or
Import a certified charter school file and verify its contents.
6. If the school district is a SELPA Administrative Unit, enter SELPA infant data in applicable entry screens.
or
Import a certified SELPA file and verify its contents.
7. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.
8. Export the data for the school district, charter schools, and SELPAs to a certified data file and send the file to your COE.
9. Print and sign the certification page(s) and send it to your COE.
Optional tasks include:
1. Printing reports for each entry screen.
2. Exporting data to an ASCII file for use in other software.
3. Printing blank certifications or certification exception.
Principal Apportionment Data Collection Software User Guide, 2018–19 Fiscal Year California Department of Education, School Fiscal Services 8
[bookmark: _Toc499721129]School District Entry Screens
Table 3 displays available entry screens, the type of data that needs to be entered, available reporting periods, and whether the entry screen allows for multiple records.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Adults in Correctional Facilities
	ADA and certification of LEA’s participation in the AICF program for the prior year.
	Yes
	Yes
	Yes
	Yes
	Yes
	No

	Annual Migrant ADA Increase
	Annual Migrant ADA is attributable to pupils of migrant agricultural workers in accordance with EC 41601.5. LEA’s can submit data to have its LCFF funding calculated using Annual ADA in lieu of P-2 ADA and certify the increase from P-2 ADA to Annual ADA. 
	No
	No
	Yes 
	No
	Yes 
	No

	Attendance School District
	ADA by category and grade span for pupils enrolled in the school district and not reported in the Attendance Supplement, Attendance Basic Aid Choice/Court Ordered Voluntary Pupil Transfer, or Attendance Basic Aid Open Enrollment. Also report P-2 ADA adjustments for the prior year and other miscellaneous categories. 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	No

	Attendance Supplement School District
	ADA by category and grade span for students residing outside a district with 25% or more P.L. 874 students [EC Section 46610]. Capistrano Unified School District (Orange County) is the only school district that can access this entry screen.
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Attendance Basic Aid Choice/Court-Ordered Voluntary Pupil Transfer
	Inter-district transfer ADA by category and grade span by district of residence for pupils attending the district pursuant to the District of Choice program [EC 48310] or as part of the Court-Ordered Voluntary Pupil Transfer program pursuant to EC 41544. 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Attendance Basic Aid Open Enrollment
	Inter-district transfer ADA by category and grade span by district of residence for a pupil that attends the district for two or more years pursuant to the open enrollment provisions [EC 48359.5].
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Class Size Penalties
	Class size data for kindergarten and grades 1 through 8 from elementary and unified school districts with more than 100 ADA.
	No
	Yes
	No
	Yes 
	No
	Yes 

	County Served District Funded ADA Transfer Selection
	School districts can elect to transfer funding for ADA served by a county office of education (COE) for which the LCFF funds flow to the district of residence. A district may choose to select some, none, or all of the COEs that serve its students. This screen is optional.
	Yes 
	No
	No
	No
	No
	No

	Necessary Small School
	Funding selection and certification for a district school that meets statutory requirements to be funded through the Necessary Small School (NSS) funding formula. Number of full-time teachers, full-time equivalent certificated employees, and ADA for each NSS. Complete prior year section only if the school did not receive NSS funding in the prior fiscal year.
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	School District Audit Adjustments to CALPADS Data
	Enrollment and unduplicated pupil counts changes to a school district’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to the CDE.
	No
	No
	Yes
	No
	Yes
	No


[bookmark: _Ref404599221][bookmark: _Ref405386585][bookmark: _Toc499721071]Table 3: School District Entry Screens
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[bookmark: _Toc499721130]Charter School Instructions
Each charter school has local procedures that should be followed to accurately report data in time for each Principal Apportionment reporting deadline. 
To report the charter school data:
1. Install the PADC Software.
2. Add a charter school user and login.
3. Select the correct reporting period.
4. Enter charter school data in applicable entry screens.
5. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens, if applicable.
6. Export the data for the charter school to a certified data file and send the file to your school district or COE.
7. Print and sign the certification page(s) and send it to your COE.
Optional tasks include:
1. Printing reports for each entry screen.
2. Exporting data to an ASCII file for use in other software.
Note:	Not all programs can be exported in ASCII format.
3. Printing blank certifications or certification exception.
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[bookmark: _Toc499721131]Charter School Entry Screens
Table 4 displays available entry screens, the type of data that needs to be entered, available reporting periods, and whether the entry screen allows for multiple records.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Charter Status
	Information about the current status of the charter school to allow CDE to appropriately calculate the charter school’s funding.
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	No

	Attendance Charter School
	ADA and days of operation by category and grade span. Also report ADA for other miscellaneous categories.
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Attendance Charter School – All Charter District
	Resident and non-resident ADA and days of operation by category and grade span. Also report ADA for the miscellaneous categories. 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Attendance Charter Funded County Programs
	ADA and days of operation for charters schools established pursuant to EC 47605.5 that serve pupils for whom the COE would otherwise be responsible for providing direct education and related services.
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Attendance COE Charter School
	ADA and days of operation for charter schools established pursuant to EC 47605.5 that have students that generate funding pursuant to EC 2574(c)(4)(A) or (B) should use this screen. 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Basic Aid Supplement Charter School
	ADA used to determine if the sponsoring district of a charter school is eligible for additional funding pursuant to EC 47663. For the purposes of this entry screen, “basic aid school district” means a school district that does not receive from the state an apportionment of state funds pursuant to EC Section 42238.02(o).

	Yes 
	Yes 
	Yes 
	Yes 
	Yes 
	Yes 

	Charter School Audit Adjustments to CALPADS
	Enrollment and unduplicated pupil counts changes to a charter school’s certified CALPADS data due to an audit finding or auditor letter of concurrence. If pursuant to an auditor’s letter of concurrence, a copy of the letter must be provided to CDE.
	No
	No
	Yes
	No
	Yes
	No

	Charter School Physical Location
	School district(s) in which the charter school is physically located or has a school facility. All charters may report except for charters in all-charter districts.
	Yes
	No
	No
	No
	No
	Yes


[bookmark: _Ref405386960][bookmark: _Ref404599187][bookmark: _Toc499721072]Table 4: Charter School Entry Screens
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[bookmark: _Toc499721132]SELPA Instructions
Each SELPA Administrative Unit (AU) and local educational agency (LEA) has local procedures that should be followed to accurately report data for each Principal Apportionment reporting deadline.
To report the data for SELPA AUs and LEAs:
1. Install the PADC Software.
2. Add a SELPA user and login.
3. Select the correct reporting period.
4. Enter SELPA Administrative Unit and LEA data in applicable entry screens.
5. Ensure that the data have no errors using the Check/Save utility in the appropriate entry screens, if applicable.
6. Export the data to a certified data file and send the certified data file to your COE.
7. Print and sign the certification page(s) and send it to your COE.
Optional tasks include:
1. Printing reports for each entry screen.
2. Exporting data to an ASCII file for use in other software.
3. Printing blank certifications or certification exception.

Principal Apportionment Data Collection Software User Guide, 2018–19 Fiscal Year California Department of Education, School Fiscal Services 15
[bookmark: _Toc499721133]SELPA Entry Screens
Table 5 displays available entry screens, the type of data that needs to be entered, available reporting periods, and whether the entry screen allows for multiple records.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Infant Funding
	Total infant units, classified and certificated employee data, and infant unit transfers within SELPA.
	Yes 
	Yes 
	Yes 
	No
	Yes 
	Yes 

	Extraordinary Cost Pool Claim
	Extraordinary cost pool claim data.
	No
	No
	Yes 
	No
	Yes 
	Yes 

	Necessary Small SELPAs Extraordinary Cost Pool Claim for Mental Health Services
	Claim data for necessary small SELPAs as defined in EC 56212 for extraordinary costs associated with educationally related mental health services including out-of-home residential services.
	No
	No
	Yes 
	No
	Yes 
	Yes 


[bookmark: _Ref404599289][bookmark: _Toc499721073]Table 5: SELPA Entry Screens
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[bookmark: _Toc499721134]County Auditor Instructions
Each county auditor has local procedures that should be followed to accurately report taxes in time for each Principal Apportionment reporting deadline.
To report the taxes for the county office of education and all school districts:
1. Install either the PADC or Tax Software.
2. Add a county auditor user and login.
3. Select the correct reporting period.
4. Enter school district and county tax data in applicable entry screens by selecting the Tax Type (County or District) from the drop-down box.
5. Export the data to a certified data file.
6. Send the certified data file to your COE.
7. Print and sign the certification page and send it to your COE.
Optional tasks include:
1. Printing reports for the entry screen.
2. Exporting data to an ASCII file for use in other software.
3. Printing blank certifications, summaries, or certification exceptions.
Note:	The Tax Software package can be downloaded separately but the data elements reported through the Tax Software may also be accessed through the PADC Software. If you install the PADC Software package, it is not necessary to separately install the Tax Software package. COEs should install the PADC Software package. However, because First Principal taxes are due to the CDE before the release of the PADC Software, some COEs may choose to install the Tax Software package as well. County auditors that report taxes directly should install the Tax Software package.
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[bookmark: _Toc499721135]County Auditor Taxes Entry Screen
Table 6 displays available entry screens.
	Entry Screen Names
	Data to be Entered
	P-1
	P-2
	Annual
	Corrected P-2
	Corrected Annual
	Multiple Records

	Taxes
	School district and county taxes.
	Yes
	Yes
	Yes
	No
	Yes
	Yes


[bookmark: _Ref405464846][bookmark: _Toc499721074]Table 6: County Auditor Taxes Entry Screens 
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[bookmark: _Toc499721136][bookmark: _Toc30307258][bookmark: _Toc30308226]Installing the Principal Apportionment Software
[bookmark: _Toc499721137]This section gives an overview of the tasks that must be completed in order to properly install the PADC Software. For specific installation instructions, please refer to the Principal Apportionment Data Collection and Tax Software Installation Guide available at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp.
Installation Procedures
Installing the software from the Internet.
1. Download the software for the current fiscal year from the Internet at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp to your desktop. 
2. Find and double-click the software executable file downloaded from the Internet.
3. The InstallShield Wizard window displays.
4. The Preparing to install window displays.
5. The Welcome window displays.
6. Click Next. The Customer Information window displays. Enter your information.
7. Click Next. The Destination Folder Program window displays.
8. Click Next. The Database Folder Program window displays.
9. Click Next. The Ready to Install the Program window displays.
10. Click Install. The progress meter displays the installation status.
11. When the installation is complete, the Installation Completed window displays, and the dialog box shows whether or not the software installed successfully.
12. Click Finish.
Note:	You may be asked to restart your computer. Click Yes. After the computer restarts, you can start using the software.
[bookmark: _Toc383161916][bookmark: _Toc499721138]
Setting Compatibility Mode
After installing the PADC Software, right click on the shortcut on your desktop to set the compatibility mode to Windows XP (Service Pack 3) as shown in Figure 1. If you are using Windows XP your system should already be set to Windows XP. However, if you are using Windows 7, Windows 8, or Windows 10 we strongly recommend you run the PADC Software in this mode to alleviate errors caused by compatibility issues between Windows 7, Windows 8, Windows 10, and the PADC Software.
[image: ]
[bookmark: _Ref405542150][bookmark: _Toc499721089][bookmark: _Toc383161908][bookmark: _Ref404594619]Figure 1: Compatibility Mode Window 
[bookmark: _Toc499721139]
Version Checking
Version checking is an important method used to ensure the correct version of the software is being used. When you open the software, the Logon screen displays the version number (Figure 2). Check the version number on the CDE Web site at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp.
[image: ]
[bookmark: _Ref14251466][bookmark: _Toc21748988][bookmark: _Toc25741594][bookmark: _Toc32033776][bookmark: _Toc382818983][bookmark: _Toc499721090]Figure 2: Sample Version Number on the Logon Screen
[bookmark: _Toc499721140][bookmark: _Toc499721141]
Basic Operating Procedures
Adding a New User
You can add one or more users to the system. Add a user by clicking the New User button in the Logon screen. After you click the New User button, the New User screen displays (Figure 3).
[image: ]
[bookmark: _Ref13320128][bookmark: _Toc21748989][bookmark: _Toc25741595][bookmark: _Toc32033780][bookmark: _Toc382818984][bookmark: _Toc499721091]Figure 3: New User Screen
From the new user screen, you can now subscribe to the Principal Apportionment PASE Listserv to stay informed of apportionment information. Click on the join-pase-contacts@mlist.cde.ca.gov link and send a blank email.

Some fields are not active until after you select other fields. For example, the County field is not active until you select a user group from the User Group field. You must enter data in the required fields to save the record. These required fields are noted in Table 7.
	Field
	Description
	Notes

	Contact Name
	Your user login name. 
	Required field.

	User Group
	Select the user group from the drop-down list. 
	Required field.

	County
	Select the county from the drop-down list. 
	Required field.

	School District
	Select the school district from the drop-down list. 
	Required field. 
This field is disabled for county office and county auditor user groups. The field changes to SELPA AU for the SELPA user group.

	SELPA AU
	Select the SELPA Administrative Unit from the drop-down list.
	Required field.
This field only displays for a SELPA user group.

	School
	Select the school from the drop-down list.
	Required field for the charter school user group. This field is only active for a charter school user group.

	Phone
	Your telephone number. 
	Required field.

	Fax
	Your fax number.
	Optional field.

	Email
	Your email address.
	Required field.


[bookmark: _Ref14960592][bookmark: _Toc17275887][bookmark: _Toc18421104][bookmark: _Toc18421491][bookmark: _Toc18421894][bookmark: _Toc19627170][bookmark: _Toc20133594][bookmark: _Toc21748814][bookmark: _Toc21748990][bookmark: _Toc25741565][bookmark: _Toc382819011][bookmark: _Toc499721075]Table 7: New User Screen Fields
After you enter your information, click OK. If you did not enter data in a required field, a dialog box displays alerting you to the missing data. If you want to close the New User screen without saving the data you entered, click Cancel.
Once you click OK the Logon screen displays again with the new user you entered in the Please Select User dialog box.
[bookmark: _Toc499721142][bookmark: _Ref33843855]
Logging On
To log on and begin using the software after you have added a new user:
1. [bookmark: _Ref373736484][bookmark: _Ref383411615]Select the user from the Please Select User drop-down list in the Logon screen.
2. Click the Logon button. The Main menu screen displays (Figure 4). [image: ]
[bookmark: _Ref405468381][bookmark: _Toc499721092][bookmark: _Toc25741597][bookmark: _Toc32033781][bookmark: _Toc382818985][bookmark: _Ref383411670][bookmark: _Ref17046528]Figure 4: Main Menu 
[bookmark: _Ref33330420][bookmark: _Toc499721143]
Getting the Latest LEA Updates
You can update LEA information (i.e., grade levels, new districts, or new schools) in the software database with a CDE-supplied text data file by clicking the Get Latest button in the Logon screen. The CDE will supply this file upon request. After you click the Get Latest button, the Importing Data for Get Latest screen displays (Figure 5).
[image: ]
[bookmark: _Ref43095671][bookmark: _Toc382818986][bookmark: _Toc499721093]Figure 5: Importing Data For Get Latest Screen
To get the updates:
1. Click Select File.
Note:	You can close the window without importing any data by leaving the field blank and clicking the Close button.
2. Select the text file in the Open window. 
3. Click Open. The Open window closes and the file name and location displays in the text box in the Importing Data for Get Latest screen. The import process begins. A message box displays when complete. Click OK to view the Status Report. If you try to import a file with an invalid format, the Status window displays an error message. You can save, print, or close the Status window. 
4. Click Close.
[bookmark: _Ref43082052][bookmark: _Toc343516725][bookmark: _Ref383170207][bookmark: _Ref383170716][bookmark: _Ref462221585][bookmark: _Ref462221672][bookmark: _Ref462221720][bookmark: _Ref463953540][bookmark: _Toc499721144][bookmark: AccessingHelp]
Accessing Help
Clicking Help or pressing the F1 key from the Main menu or from any entry screen will link the user to the Principal Apportionment Data Collection Software Web page at https://www.cde.ca.gov/fg/sf/pa/. Select the PADC Software Fiscal Year 2018–19 link (Figure 6) to access the Resources and Documents for the current year. The following resources are available on this Web page to help a user with the submission of data: 
· Known Problems, Fixes, and Workarounds – Information on known problems and fixes for the PADC Software.
· Download and Installation Guide – Information on how to download and install the software.
· Software User Guide – Information on how to use the software and tips on how to print, save, export/import, etc.
· Data Reporting Instruction Manual – Information on how to use the data entry screens, where to report data, and description of data elements for each screen (previously known as the Help File). 
· Due Dates – List of Principal Apportionment Data Collection Software due dates for 2018–19 by entry screen.
· Contacts – List of program contacts for the Principal Apportionment by entry screen.
[image: ]  
[bookmark: _Ref41804047][bookmark: _Toc499721094][bookmark: _Toc382818987]Figure 6: Help 
[bookmark: _Ref405541531][bookmark: _Toc499721145]
Navigating Main Menus
The Main menu (Figure 4) is the starting point for entering data into the software.
[bookmark: _Toc499721146]The User Group selected when your account was created determines the Main menu screen appearance.
Main Menu Grids
There are two grids on every Main menu:
· LEA grid
· Entry Screens grid
The LEA grid displays information about the LEA(s). The columns are described in Table 8.
	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate LEA row.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


[bookmark: _Ref33856204][bookmark: _Toc382819012][bookmark: _Toc499721076]Table 8: LEA Grid Information
The Entry Screens grid displays a list of screens that you can access to enter or view data. Each row contains information about entry screen data. The columns are described in Table 9.
	[bookmark: _Ref12946975][bookmark: _Ref12947023][bookmark: _Ref12947064][bookmark: _Ref12947449][bookmark: _Ref16929952]Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time records in the entry screen were last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Not all screens are checked for errors, but the field still contains date and time information upon saving.

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


[bookmark: _Ref33856217][bookmark: _Toc382819013][bookmark: _Toc499721077]Table 9: Entry Screens Grid Information
[bookmark: _Toc499721147]
Main Menu Commands
File Menu
The File menu contains the following commands shown in Table 10.
	Command
	Description

	Import
	The Import sub-menu allows you to import either ASCII (text) files or certified data files.

	Export
	The Export sub-menu allows you to export data to an ASCII (text) file or to a certified data file. 

	Print
	The Print sub-menu allows you to print various types of reports, depending on the user group selected. Please refer to Table 19 for more information.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports and the default number of copies you will print each time.

	Logout
	The Logout command logs the current user out of the application and returns to the Logon screen.

	Exit
	The Exit command closes the program and returns you to Windows.


[bookmark: _Ref17093741][bookmark: _Toc17275892][bookmark: _Toc18421110][bookmark: _Toc18421497][bookmark: _Toc18421900][bookmark: _Toc19627176][bookmark: _Toc20133600][bookmark: _Toc21748815][bookmark: _Toc21748996][bookmark: _Toc25741566][bookmark: _Toc382819014][bookmark: _Toc499721078]Table 10: File Menu Commands
Period Menu
The Period menu allows you to switch between different reporting periods for the current fiscal year and for corrections. 
There are three reporting periods for each fiscal year software (P-1, P-2 and Annual) and two reporting periods for corrections (P-2 and Annual). When you open the software for the first time, the default reporting period selected is P-1. Each time you reopen the software after that, it will always open to the last reporting period used.
Note:	A checkmark displays next to the selected period in the Period menu.
When reporting data for the current fiscal year, select a period by selecting P-1, P-2 or Annual from the Period menu. When reporting data for corrections, select Corrected from the Period menu, then select P-2 or Annual from the sub-menu. The list of entry screens available may change for the specific period.

LEA Menu
The User Group selected when the account was created determines the LEA menu choices. The LEA menu displays differently for COEs, school districts, charter schools, county auditors, and SELPAs.
[bookmark: _Ref45613209]Note: The software automatically displays the LEA menu based on the User Group.
Tools Menu
The options available in the Tools menu depend on the user group selected. Table 11 displays a summary of the commands available by user group.
	Command
	SELPA
	County Auditor
	Charter
	School District
	COE
	Description

	User Information
	Yes
	Yes
	Yes
	Yes
	Yes
	The User Information screen displays your current user information and allows for modification to the contact name, telephone number, fax number, and email fields. You cannot change your user group, county, school district, or school from this screen. You must create a new account if you want to change this information.

	Contact Information
	Yes
	No
	Yes
	Yes
	Yes
	The Contact Information screen displays user information for lower-level LEAs. For example, Alameda county can access the user information for school districts and charter schools within the county, provided they have imported data from them.

	Upload Certified Data
	Yes
	No
	No
	No
	Yes
	Sends the final certified data file to the CDE.


[bookmark: _Ref43185837][bookmark: _Toc382819015][bookmark: _Toc499721079]Table 11: Available Tools Menu Commands

Help Menu
The Help menu is a useful tool if you need assistance with a particular entry screen or program function. For more information on utilizing Help, see the Accessing Help Section.
[bookmark: _Toc499721148][bookmark: _Ref43082129]Clicking About displays the version number of the software, similar to the Logon screen. To return to the PADC Software, click OK. If you would like to view your Windows system information, click System Info. The System Information window displays information about your hardware, software, and Windows environment.
Selecting and Opening an Entry Screen
To select and open an entry screen:
1. Select the LEA by clicking the far left column of your selected LEA row in the top grid of the Main menu screen.
2. Open the entry screen by clicking the far left column of the entry screen row in the bottom grid of the Main menu screen. 
Note: 	If you cannot view the entire entry screen, use the vertical and horizontal scroll bars on the right and bottom sides of the screen, respectively. If your computer has higher video resolution, you may be able to resize your window so more of the entry screen displays.
When you open an entry screen that contains existing data, the data displays in the proper fields.
The data is entered into “cells.” Some cells may be disabled (grayed out). These disabled cells are used to show calculated values or to prevent a user from entering data that does not apply to them. Figure 7 displays a sample entry screen.
[image: ]
[bookmark: _Ref405468613][bookmark: _Toc499721095][bookmark: _Toc382818988][bookmark: _Ref43095735]Figure 7: Sample Entry Screen 
[bookmark: _Ref43089954][bookmark: _Ref462226983][bookmark: _Toc499721149]You can enter data by typing the value into that field. If you have a fractional amount, you can enter that value by pressing the PERIOD key after you enter the whole number, and then type the two digit decimal amount. For example, if the amount is 230.25, type 230, press the PERIOD key, and then type 25. If you do not have a whole number value that precedes the decimal point, such as 0.75, press the PERIOD key first and then type 75.
Selecting LEAs and Entry Screens for Printing and Exporting to an ASCII (Text) File
You can choose either all or selected LEAs and entry screens for printing from the Main menu. You can choose either all or selected LEAs, but only one entry screen at a time for exporting to an ASCII (text) file from the Main menu.
To select all LEAs and entry screens for printing:
1. If only one row displays in the top grid of the Main menu, click the SELECTED column cell for that LEA row to change it to “Yes.” If more than one row displays in the grid, click the Select All button above the top grid. Each row in the top grid displays “Yes” in the SELECTED column.
2. Click the left arrow in the top grid. The Entry Screens grid (the lower grid in the Main menu) is now active.
3. Click the Select All button above the Entry Screens grid. Each row in the Entry Screens grid displays “Yes” in the SELECTED column. You can now print reports for all LEAs and entry screens that have data.
To select specific LEAs and entry screens for printing or exporting to an ASCII (text) file:
1. In the top grid of the Main menu, click the SELECTED column cell in each LEA row you want to print or export to an ASCII (text) file. The top grid displays “Yes” in the SELECTED column of each LEA row you click.
2. Click the cell to the left of any row in the top grid. The Entry Screens grid (the lower grid in the Main menu) is now active.
3. Click the SELECTED column cell of each program you want to print a report for or click the SELECTED column cell of one program to export to an ASCII (text) file. The Entry Screens grid displays “Yes” in the SELECTED column of each entry screen you select. You can now print reports for the selected LEAs and entry screens which have data, or export all selected LEAs and one entry screen that has data to an ASCII (text) file.
Note: Deselect LEAs and entry screens by clicking the Deselect All button or by clicking the SELECTED column cell(s) of any LEA or entry screen to change the cell(s) to No.

Note:	Not all programs can be exported in ASCII format.
[bookmark: _Toc499721150]
Entering Data
[bookmark: _Toc499721151]This section explains how to use entry screen commands, add and delete records in entry screens that contain multiple records, and switch between tabbed and drop-down menus.
Entry Screen Commands
File Menu
The File menu displays the options shown in Table 12.
	Command
	Description

	Save
	Saves the entered data. A dialog box is displayed whenever you try to close an entry screen without saving the data. If you click No in the dialog box, the program discards the data and you cannot retrieve it. If you click Yes, the program saves the data and that data displays the next time you open the entry screen.

	Check/Save
	Runs a series of validations to determine if the saved data passes the edit check process. If there are errors, an edit check report displays (for more information about edit check reports, see the Edit Check Reports Section). Not all entry screens have the Check/Save option enabled.

	Print
	The Print sub-menu allows you to print a report based on the data saved in the entry screen. After selecting Print, a print preview is displayed. From the print preview screen, you can print or export the report. The report will print using the default printer installed in your Windows application. All reports print on standard 8.5" x 11" paper. Each report displays the date and time of printing.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.

	Close
	Closes the entry screen and returns you to the Main menu.


[bookmark: _Ref33855654][bookmark: _Toc382819016][bookmark: _Toc499721080]Table 12: File Menu Commands
Note Menu
Selecting Add Note from the Note menu opens a window for creating and saving Notes to entry screens. Figure 8 displays a sample Notes window. Enter any relevant information in the text box provided and click Save. 

If you enter text into the Notes dialog box and then try to close the dialog box without saving, a dialog box displays and asks if you want to save the note. If you click No, the program discards the note and you cannot retrieve it. If you click Yes, the program saves the note and that note will display in the Notes dialog box the next time you open the dialog box. After you save your note and then save the data in the associated entry screen, you can view the saved note every time you access the Notes dialog box. The buttons are displayed in Table 13.
Note: Deleting data in the entry screen also deletes your note.
[image: ]
[bookmark: _Ref405468763][bookmark: _Toc499721096][bookmark: _Toc32033791][bookmark: _Toc382818989][bookmark: _Ref89653343]Figure 8: Sample Notes Window 
	Button
	Description

	Save
	This button saves the note with your data. Every time you open the screen your note displays when you open the Notes dialog box. 

	Cancel
	Removes text that you entered after you opened the dialog box. If you saved text in the dialog box, the program does not remove that saved text.

	Delete
	Deletes all text in the Notes dialog box. When you click Delete a dialog box displays asking if you want to remove the text; when you click Yes the program deletes the text and you cannot retrieve it.

	Close
	Closes the Notes dialog box.


[bookmark: _Ref404599773][bookmark: _Toc499721081]Table 13: Note Menu Buttons

Tools Menu (from an entry screen)
The Tools menu displays additional entry screen functions. For example, in the Taxes entry screen, a county auditor can use the Copy P-1 to P-2 option in the Tools menu to copy P-1 tax data to P-2. 
Note: The Tools menu is only available in the Taxes entry screen and the Special Education Tax Allocation entry screen. 
Help Menu (from an entry screen)
[bookmark: _Toc499721152]The Help menu functions in the same manner as on the Main menu screen. Please refer to Accessing Help for more information on utilizing Help.
Entering Data into Single Record Entry Screens
Some entry screens only allow one record to be created for the selected LEA (Figure 9).
[image: ]
[bookmark: _Ref405468885][bookmark: _Toc499721097][bookmark: _Toc382818990][bookmark: _Ref45597511]Figure 9: Sample Single Record Entry Screen 
In single record entry screens, the Save, Check/Save, Delete, Cancel, and Close buttons are displayed.
Note:	The Check/Save button is not available in all entry screens.
[bookmark: _Toc499721153]
Entering Data into Multiple Record Entry Screens
Some entry screens allow multiple records to be created. Multiple Record Entry Screens will include navigation buttons as shown in Figure 10.
[bookmark: _Ref17095819][bookmark: _Toc532629519][bookmark: _Toc21749002][bookmark: _Toc25741604][bookmark: _Toc32033793][bookmark: _Toc382818991][bookmark: _Toc499721098][image: ]Figure 10: Sample Multiple Record Entry Screen
Select an existing record, add a new record, or delete the currently selected record by clicking on one of the following buttons as shown in Table 14.
	Button
	Description

	[image: Toggle button to move to the first record.] First record button
	Moves to the first record.

	[image: Toggle button to move to the previous record.] Left arrow button
	Moves to the previous record.

	[image: Toggle button to move to the next record.] Right arrow button
	Moves to the next record.

	[image: 024d] Last record button
	Moves to the last record.

	[image: Add New button adds a new record.] Add new button
	Adds a new record.

	[image: Delete button deletes the currently selected record.] Delete button
	Deletes the currently selected record.


[bookmark: _Ref17118124][bookmark: _Toc14975835][bookmark: _Toc17275899][bookmark: _Toc18421504][bookmark: _Toc18421907][bookmark: _Ref19554649][bookmark: _Toc19627183][bookmark: _Toc20133607][bookmark: _Toc21748818][bookmark: _Toc21749003][bookmark: _Toc25741568][bookmark: _Toc382819018][bookmark: _Toc499721082]Table 14: Multiple Record Entry Screens Navigation Buttons

Adding Records
To add a record to the screen:
1. Click on the Add New button. The Add New Record screen displays, similar to the one shown in Figure 11.
[bookmark: _Ref405468994][bookmark: _Toc499721099][bookmark: _Toc382818992][bookmark: _Ref45598593][image: ]
Figure 11: Sample Add New Record Screen 
2. Choose the LEA you want to enter data for, and then click on the Add Record button. You can now enter data for that LEA. Figure 12 shows an entry screen after completing the Add New record entry screen.
[image: ]
[bookmark: _Ref45596270][bookmark: _Toc382818993][bookmark: _Toc499721100]Figure 12: Sample Entry Screen after Adding A New Record
3. Click Save to save the record. 
Note: A user can change previously saved data in any record. However, the changed data will replace the previously saved data.
4. Add additional records by following steps 1–3.
Moving Through Fields
You can move to a different field in two ways. You can press the TAB key to move the cursor to the next field, or you can move the mouse pointer over the field you want and then click the left mouse button. You can move to the previous field by pressing SHIFT+TAB. The program highlights the value in that field once the cursor displays there. If the next field does not display in the window, the program scrolls up or down the entry screen to display your selected field.
Entering Negative Numbers
Use the minus ( - ) sign before or after a number to enter a loss, or negative value, in an entry field. The value will then display in parentheses on the entry screen and on the corresponding report.
Deleting Records
To delete a record:
1. Select the record you want to delete.
2. Click on the Delete button.
3. Click Yes in the Delete dialog box.
Selecting and Searching for Records
If you want to open a saved record in the entry screen, you can select an existing record by using the arrow buttons described in Table 14. 
Some entry screens have an additional search feature ([image: Picture of the search button that has an image of binoculars.]). For example, you can search for records in the Class Size Penalties entry screen by following these steps:
1. Enter the average class enrollment size you want to search for into the text box at the lower left corner of the entry screen.
2. Click the search button ([image: Picture of the search button that has an image of binoculars.]). The first record with the enrollment size you entered in the text box displays in the entry screen. You can search for the next record that contains the enrollment size (for Less Than Full Second Period selection) by clicking the search button ([image: Picture of the search button that has an image of binoculars.]) again.
[bookmark: _Toc499721154]A dialog box displays when you reach the last record or if the record was not found.
Switching Between Tabbed and Drop-Down Menus
Each entry screen contains one or more tabs. These tabs display in a row at the top of the screen (Figure 13).
[bookmark: _Ref17118078][bookmark: _Toc14255198][bookmark: _Toc21749005][bookmark: _Toc25741606][bookmark: _Toc32033795][bookmark: _Toc382818994][bookmark: _Toc499721101][image: ]Figure 13: Entry Screen Tabs
If an entry screen has more than one tab, you can move to each entry screen by clicking on the tab. After you click the tab the screen for that tab displays.
At the end of the tab row the Drop-Down menu button ([image: Picture of the munu button.]) displays. When you click this button the tab menu changes to a drop-down text box showing the name of the currently selected tab with a drop-down arrow on the right. The Drop-Down menu button changes to the Tabs button (Figure 14). 
[bookmark: _Ref17118090][bookmark: _Toc14255199][bookmark: _Toc21749006][bookmark: _Toc25741607][bookmark: _Toc32033796][bookmark: _Toc382818995][bookmark: _Toc499721102][image: ]Figure 14: Entry Screen Drop-Down Menu
[bookmark: _Toc499721155]You can view each tab by clicking on the drop-down arrow and then selecting a screen from the drop-down list. You can revert back to tab view by clicking on the Tabs button 
([image: Picture of the tabs button]).
Resizing Windows
[bookmark: _Toc14975595][bookmark: _Toc15027717][bookmark: _Toc17048741][bookmark: _Toc17117063][bookmark: _Toc17274500][bookmark: _Toc17274646][bookmark: _Toc17566420][bookmark: _Toc18420943][bookmark: _Toc18421329][bookmark: _Toc19456479][bookmark: _Toc19555312][bookmark: _Toc19555474][bookmark: _Toc19555636][bookmark: _Toc19627008][bookmark: _Toc19797950][bookmark: _Toc19798112][bookmark: _Toc20122640][bookmark: _Toc20133427][bookmark: _Toc20203982]You can resize a window by moving your mouse pointer to an edge or the corner edge of the window. The pointer changes into a two-sided vertical arrow when the pointer is moved over the top or bottom edge, a two-sided horizontal arrow when the pointer is moved over the left or right edge, or a two-sided diagonal arrow when the pointer is moved over a corner edge. Then you can hold down your left mouse button and move the mouse to shrink or enlarge the window size.
[bookmark: _Ref33845269][bookmark: _Toc499721156]
Edit Check Reports
After data is entered, users should run a validation process on their data. This section describes how to perform the edit checks.
Note: Not all entry screens have the Check/Save option enabled.
To check your data for errors:
1. Enter data into the entry screen.
2. Click the Check/Save option or button, if available. The program saves your data and checks it to ensure that no errors exist. If no errors exist, a dialog box displays to inform you that the data have passed the error check process (Figure 15).
[bookmark: _Ref17117329][bookmark: _Toc14255200][bookmark: _Toc25741651][bookmark: _Toc32033797][bookmark: _Toc382818996][bookmark: _Toc499721103][image: ]
Figure 15: Edit Check Process Message Box
If an error does exist, an Edit Check report displays the error as shown in the sample on 
Figure 16.
[bookmark: _Ref41804412][bookmark: _Toc382818997][bookmark: _Toc499721104][image: Sample Edit Check Report 
Lists County,  Fiscal Year, district, and CDS Code.
There is a chart that shows the line number, field caption, type, and message.]
Figure 16: Sample Edit Check Report
The Edit Check Report displays a table listing fields that contain invalid data. Table 15 describes the information in each column.
	Column
	Description

	Line No
	The line number in the entry screen that contains the erroneous field.

	Field Caption
	The name of the field.

	Type
	The error severity type: E (error) or W (warning). An error with type E is a fatal error, and you will not be able to certify and export the data until you fix the problem as stated in the Message column. A type W error is a warning that reminds you about possible errors or problems in the entry screen. Warnings do not affect your ability to certify and export the data.

	Message
	The message in this column instructs you how to rectify the error.


[bookmark: _Ref17117327][bookmark: _Toc14975836][bookmark: _Toc17275906][bookmark: _Toc18421511][bookmark: _Toc18421914][bookmark: _Toc19627263][bookmark: _Toc20133687][bookmark: _Toc25741583][bookmark: _Toc382819019][bookmark: _Toc499721083]Table 15: Edit Check Report Information
The Edit Check screen contains the following functions as shown in Table 16.
	Button/Function
	Description

	[image: Print button sends report to the printer.] Printer button
	Sends the report to the printer.

	[image: Export button exports the report into an HTML or ASCII (text) file.] Folder button
	Exports the report into an HTML or ASCII (text) file.

	[image: Zoom feature allows the user to set the magnification level from the drop-down list.]
Zoom button
	Sets the magnification level from the drop-down list.

	[image: Toggle button to move to the first page in the report.] First page button
	Moves to the first page in the report.

	[image: Toggle button to move to the previous page in the report.] Left arrow button
	Moves to the previous page in the report.

	[image: Toggle button to move to the next page in the report.] Right arrow button
	Moves to the next page in the report.

	[image: Toggle button to move to the last page in the report.] Last page button
	Moves to the last page in the report.


[bookmark: _Ref17273718][bookmark: _Toc14975837][bookmark: _Toc17275907][bookmark: _Toc18421512][bookmark: _Toc18421915][bookmark: _Toc19627264][bookmark: _Toc20133688][bookmark: _Toc25741584][bookmark: _Toc382819020][bookmark: _Toc499721084]Table 16: Edit Check Screen Functions
3. Click OK to close the edit check passed message box, or click [image: X Button to Close.] to close the Edit Check Report. 
4. Make the necessary corrections in the entry screen until there are no fatal errors.
5. Close the entry screen.
[bookmark: _Toc499721157]
Correcting Data from a Prior Period
If you need to submit corrected data for the P-2 or Annual reporting period, you can input corrected data by selecting the Period menu, then selecting P-2 or Annual from the Corrected sub-menu.
If you have not yet submitted data or need to correct data and the reporting deadline has recently passed, contact CDE to determine if an original (non-corrected) file may still be accepted.
[bookmark: _Toc499721158]Note: 	You must use the appropriate fiscal year software to make corrections. For example, you would use the 2016–17 software in fiscal year 2018–19 to make the 2016–17 corrections. Any data that is changed replaces previously saved data.
Corrected Period Main Menu
When you log in and select a corrected period from the Period menu, the Main menu displays the CORRECTED columns shown in Figure 17.
[bookmark: _Ref405469110][bookmark: _Toc499721105][bookmark: _Toc382818998][bookmark: _Ref33854732][image: ]Figure 17: Main Menu Screen for Corrected Periods 
The LEA grid columns in a corrected period’s Main menu are described in Table 17.
	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate LEA row.

	CORRECTED
	Denotes whether corrections have been made. The default selection is No.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


[bookmark: _Ref33854823][bookmark: _Ref33854816][bookmark: _Toc382819021][bookmark: _Toc499721085]Table 17: LEA Grid Columns for Corrected Periods
The Entry Screens grid columns for corrected periods are described in Table 18.
	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CORRECTED
	Denotes whether corrections have been made to the data in the entry screen. The default selection is No.

	REASON CODE
	The reason code for the correction.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time the entry screen was last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Note: Not all entry screens have the Check/Save option enabled.

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


[bookmark: _Ref43084125][bookmark: _Toc382819022][bookmark: _Toc499721086][bookmark: _Toc499721159]Table 18: Entry Screen Grid Columns for Corrected Periods
Correcting Data
To enter corrected data:
1. Select Corrected from the Period menu.
2. Select the period (P-2 or Annual) you want to correct from the Corrected submenu. 
3. Select the LEA in the top grid to activate the Entry Screens grid.
4. Open the entry screen to correct and make any necessary changes to the data.
Note:	Data entered in the standard P-2 or Annual reporting periods will be displayed in the entry screen fields.
5. Click Save or Check/Save.
Note:	Remember to click Check/Save (if available) to ensure the entered data passes the edit check process.
6. Click Close to close the entry screen.
7. Upon closing the entry screen, the Correction Reason dialog box displays as shown in Figure 18.
Note:	The Correction Reason screen will not display unless data (original or corrected) has been saved in the entry screen.
[bookmark: _Ref405469202][bookmark: _Toc499721106][bookmark: _Toc382818999][bookmark: _Ref33855086][image: ]
Figure 18: Correction Reason Screen 
8. Select the reason for the correction from the Correction Reason drop-down list.
9. Type correction notes in the Correction Notes text box.
Note:	You must enter notes in this text box. Do not leave the text box blank.
10. Click Close. The Correction Reason screen closes and the Main menu displays.
Note:	In the Entry Screens grid, the CORRECTED column displays “Yes” and the correction reason selected is displayed in the REASON CODE column. In the top grid, the CORRECTED column for the LEA row that was corrected displays “Yes.”
[bookmark: _Toc499721160]Once the CORRECTED column displays “Yes,” you can re-enter the Correction Reason dialog box by clicking the “Yes” in the CORRECTED column cell in the Entry Screens grid if you need to edit the correction reason or notes. Click Save. If Delete is checked, all notes will be deleted. If a new note is added, you must click Save before Close or the new information will not be saved.
Saving Data in P-2 and Annual Reporting Periods
Any data that is changed and saved replaces previously saved data. If you change and save P-2 or Annual corrected period data, the data changes OVERWRITE the previously saved P-2 or Annual period data. Conversely, if you change and save P-2 or Annual data in the “standard” (meaning from the Period menu, not from the Period menu’s Corrected sub-menu) reporting period, the saved changes overwrite any existing P-2 or Annual corrected period data.
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[bookmark: _Toc499721161]Importing and Exporting
[bookmark: _Toc499721162]Once data is entered, it can be exported to a file and/or imported to another program. This section describes how to import and export data files and send those files to the CDE.
[bookmark: _Toc499721163]Importing Data Files
Importing ASCII Files
You can import data into the program from a properly formatted ASCII (text) file. To see the format of the ASCII file, you can open it in Notepad. Data must be in the proper sequence and format to be imported. 
To import an ASCII (text) file from the Main menu screen:
1. Click Import from the File menu.
2. [bookmark: _Ref17273157][bookmark: _Toc25741663][bookmark: _Toc32033800]Click ASCII File in the submenu. The Importing ASCII Data screen displays (Figure 19).
[bookmark: _Ref43096674][bookmark: _Toc382819000][bookmark: _Toc499721107][image: ]Figure 19: Importing ASCII Data Screen
3. Click Select File and select the file you want to import.
4. Click Open.
After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing ASCII Data screen without importing any data by leaving the field blank and clicking Close.
Note:	If the program cannot import the file, a dialog box will display and inform you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data. 
[bookmark: _Toc499721164]Note:	In a multiple record file, the import will overwrite existing like-records and add new records, but it will not delete records. If, after you import a file, the Certificate Number and/or Number of Records do not match the expected Certificate Number and/or Number of Records, you must delete the records using the delete button on the data entry screen and import the file again. 
Importing Certified Data Files
You can import a certified data file into the program.
To import a certified data file from the Main menu screen:
1. Click Import from the File menu.
2. Click Certified Data in the submenu. The Importing Certified Data screen displays (Figure 20).
[bookmark: _Ref45604906][bookmark: _Toc382819001][bookmark: _Toc499721108][image: ]Figure 20: Importing Certified Data Screen
3. In the Importing Certified Data screen, click Select File.
4. Select the file you want to import.
5. Click Open.
After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing Certified Data window without importing any data by leaving the field blank and clicking Close.
Note:	If the program cannot import the file, a dialog box will display and inform you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data.
Note:	In a multiple record file, the import will overwrite existing like-records and add new records, but it will not delete records. If, after you import a file, the Certificate Number and/or Number of Records do not match the expected Certificate Number and/or Number of Records, you must delete the records using the delete button on the data entry screen and import the file again. 
[bookmark: _Toc499721165][bookmark: _Toc499721166]
Exporting Data Files
Selecting Data to Export
You can export entry screen data to an ASCII (text) file or a certified data file, but first you must select data to export. The process for selecting data depends on whether you want to export an ASCII (text) file or certified data file.
Selecting LEAs and Entry Screens for Exporting to an ASCII (Text) File
[bookmark: _Ref55372411]Note:	Not all programs can be exported in ASCII format.
You can export data to an ASCII (text) file for internal distribution. 
To export entry screen data into an ASCII file:
1. Select the LEA(s) and entry screen you want to export (see the Accessing Help Section).
2. Click Export from the File menu.
3. Click ASCII File in the submenu. The Save As window displays.
4. Navigate to a folder and enter the file name in the File name field or accept the default folder and file name.
5. Click Save. The Status window displays.
6. Save, print, or close the Status window.
Selecting LEAs and Entry Screens for Exporting to a Certified Data File
You must export the data you entered in the program to a certified data file to send to the CDE by the filing dates. You can export Selected Certified Data or All Certified Data.
Access the Export Certified window by selecting Export from the File menu, then selecting Certified Data from the sub-menu.
You can select all LEAs and entry screens, or individual LEAs and entry screens for data export to a certified data file by using the Export Certified window. 
Exporting Selected Certified Data
To export Selected Certified Data:
1. Click Export from the File menu.
2. Click Certified Data in the submenu. The Export Certified window displays (Figure 21).
[bookmark: _Ref41790777][bookmark: _Toc382819002][bookmark: _Toc499721109][image: ]Figure 21: Export Certified Window
Note:	The Export Certified window will display differently depending on your user group type. 
The Export Certified window displays two panes. The left pane displays a tree view of all LEAs, and the right pane displays a tree view of all available entry screens. 
Selecting checkboxes in each pane automatically selects each branch of the tree.
3. Navigate through the Export Certified window and select the checkbox beside each LEA and entry screen you want to export. When making selections, appropriate combinations of LEAs and programs must be selected. For example, if only the Charter School(s) box is selected in the left pane, and a County Offices of Education program is selected in the right pane, an error message will display. 
4. Click the “+” sign to view all items in each LEA or program. Click the “-“ sign to hide the items.
5. To select all county, district, and charter school LEAs for export, select the checkbox to the left of LEA(s) (at the top of the left pane). To select all county, district, and charter programs for export, select the checkbox to the left of Program(s) (at the top of the right pane). SELPA LEAs and programs must be selected separately.
[bookmark: _Toc499721110][image: ]Figure 22: Export Certified Window with All LEAs and Programs Selected
Note: Audit Adjustments to CALPADS Data cannot be exported with any other program(s) (e.g. Attendance, Taxes, and SELPA). When a user attempts to export Audit Adjustments to CALPADS Data with other program(s), a screen will appear to advise the user that Audit Adjustments to CALPADS Data must be exported separately.
[bookmark: _Toc499721111][image: ] Figure 23: Exporting Audit Adjustments to CALPADS Data Message Box
6. To select individual LEAs and entry screens, navigate through the left and right panes and select the checkbox beside each LEA and entry screen you want to export.
7. Click Export. The Data Modification window displays.
8. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see the Data Modification Section). 
9. Click OK. The Status window displays. 
Note: You can save, print, or close the Status window.
10. Close the Status window.
11. Close the Export Certified window by clicking the Cancel button.
Note: If you get an Export Failed error in your Export Status window, check the Entry Screens grid to see if there are errors or if the Last Modified Date and Last Edit Check Date are the same or not. The date and time in the Last Modified Date column only indicates when you saved the data, not the last time you checked the data for errors. Open the data entry screen and click the Check/Save button to ensure there are no errors. Close the data entry screen and ensure that the Last Modified Date and Last Edit Check Date are the same.
12. In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.
Exporting All Certified Data
To export All Certified Data:
1. Click Export from the File menu.
2. Click Certified Data in the submenu. The Export Certified window displays.
3. Select the LEA(s) checkbox in the left pane of the Export Certified window. A check mark is displayed in the check box.
4. Select the Program(s) checkbox in the right pane of the Export Certified window. A check mark is displayed in the check box.
Note:	Because there may be different due dates for an entry screen, you should expand the trees in the right pane and only check the appropriate program box when exporting data for the CDE. A list of due dates by entry screen is available at https://www.cde.ca.gov/fg/sf/pa/padcsw1819.asp under the Resources and Documentation header.
5. Click Export. The Data Modification window displays.
6. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see the Data Modification Section).
7. Click OK. The Status window displays.
8. Close the Status window.
Note:	If SELPA data needs to be exported, two export files must be prepared. One file containing all county, school district, charter school and tax data must be prepared, and one containing only SELPA data must be prepared.
9. Close the Export Certified window.
Note:	If you get an Export Failed error in your Export Status window, check the Entry Screens grid to see if there are errors or if the Last Modified Date and Last Edit Check Date are the same or not. The date and time in the Last Modified Date column only indicates when you saved the data, not the last time you checked the data for errors. Open the data entry screen and click the Check/Save button to ensure there are no errors. Close the data entry screen and ensure that the Last Modified Date and Last Edit Check Date are the same.
10. [bookmark: _Ref33855389]In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.
Data Modification
The Data Modification window (Figure 24) must be used to explain any changes you have made to data that you are submitting. 
Note: The Data Modification window is user group specific, e.g. the questions and certification language are different depending on user group type.
[image: ]
[bookmark: _Ref43096731][bookmark: _Toc25741667][bookmark: _Toc32033804][bookmark: _Toc382819004][bookmark: _Ref435796793][bookmark: _Toc499721112]Figure 24: Sample Data Modification Window
This window must be completed before the export file creation process will begin.
1. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions.
2. Click OK after answering all of the questions. The export process will commence.
3. Upon completion, a status window will display with details on the data exported.
4. You can then print a Certification Report for your records. (For more information on printing a Certification report, see the Printing Reports from the Main Menu Section).
[bookmark: _Toc499721167][bookmark: _Toc499721168]
Submitting Certified Data Files
Sending Certified Files to the COE
This section applies to school districts, charter schools, county auditors, and Special Education Local Plan Areas (SELPAs).
After you export your data to a certified data file, send the certified file to your school district or COE.
For example, a charter school user will enter their data into their entry screens, export their certified data to a certified data file, and send the export file to their school district. The district will import the file(s) received from their charter school(s). The district will also enter their data into their entry screens. The district will export all the data (district and charter) to a certified data file, and send the export file to their county.
Email makes the submission process quick and easy; however, you must also submit your signed certification page(s) to your district or COE. 
[bookmark: _Toc499721169]Your Internet Service Provider (ISP) may have attachment size limits, so ensure that email attachments do not exceed the size limit. Contact your ISP for more information.
Uploading Certified Data
This section only applies to a COE.
After a COE exports all of their files and any files received from their LEAs to a certified data file, COEs must send the certified file to CDE via File Transfer Protocol (FTP). The PADC Software contains an FTP component. 
Additionally, the County Superintendent must sign the Certification page(s) submitted from their district(s) and/or charter school(s) and keep them on file.
To upload a certified data file:
1. Select Upload Certified Data from the Tools menu. The Submit Datafile window displays (Figure 25).
[bookmark: _Ref89663296][bookmark: _Toc382819005][bookmark: _Toc499721113][image: ]Figure 25: Submit Datafile Window
2. Enter the COE password and click Select File. The Select Datafile to Submit window displays (Figure 26). 
Note:	The COE password is specific to each county office of education. If the password is lost or not working, please send an email from the County Superintendent or chief business official to PASE@cde.ca.gov. 
[bookmark: _Ref89664022][bookmark: _Toc382819006][bookmark: _Toc499721114][image: ]Figure 26: Select Datafile to Submit Window
Note: If you cannot see the Export file, the exported files could be in the Virtual Export folder. To see the files in the Virtual Data Export, click “Compatibility files” for the Export folder you want to view. After displaying the Virtual Export folder, you will be able to see the files in the Export folder. You can then copy/paste the export file to another location. You may need to use Ctrl-V to paste the export file(s) into an email.
Note:	If the password is not entered, the Enter Password message box displays (Figure 27).
[image: ]
[bookmark: _Ref89664707][bookmark: _Toc382819007][bookmark: _Toc499721115]Figure 27: Enter Password Message Box
Note:	If the incorrect password is entered, the Incorrect Password message box displays (Figure 28).
[image: ]
[bookmark: _Ref89664785][bookmark: _Toc382819008][bookmark: _Toc499721116]Figure 28: Incorrect Password Message Box
3. Select the file to submit and click Open. The Uploading Confirmation message box displays (Figure 29).
[bookmark: _Ref89666203][bookmark: _Toc382819009][bookmark: _Toc499721117][image: ]
Figure 29: Uploading Confirmation Message Box
4. If the correct file name is displayed in the message box, click Yes. When the upload process is complete, a Status window displays showing the results of the upload process. 
Note:	An example of a valid data file name would be PADCSV17_00_1_01_Nov_02_2018_07_33_25
5. Click Close to close the Status window. (Figure 30)
[image: ]
[bookmark: _Ref405465795][bookmark: _Toc499721118]Figure 30: Operation Complete Status Window
6. Click Close to close the Submit Datafile window.
[bookmark: _Ref46022914][bookmark: _Toc499721170]
Printing Data
Reports can be printed from the entry screen or the Main menu using the software’s Print utility. Before you print reports, you should set up your printer.
[bookmark: _Toc499721171]From the File menu, select Printer Setup to open a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.
Printing Reports from an Entry Screen
Each individual entry screen has a report associated with it. The reports display in the Print Preview window.
To print an entry screen report:
1. Open the entry screen.
2. Select Print from the File menu. The Print Preview window opens.
Note:	To view more of the report on-screen you can resize the window, or select a zoom percentage from the Zoom drop-down list. Click the navigation ([image: Picture of the navigation buttons. Scroll arrows to go to the first page, previous page, then a window that shows the page number, followed by scroll arrows to go to next page, and last page. ]) buttons to scroll through the pages of the report.
3. Click the Print button ([image: Picture of the print button that displays a printer]). The Print dialog box opens.
4. Click OK. The report is sent to the printer.
Note:	A report that should print in landscape orientation may print in portrait orientation on an Enterprise printer. You will need to manually set the printer orientation to landscape before printing the report.
5. [bookmark: _Printing_Reports_from][bookmark: _Ref46022946][bookmark: _Toc499721172][bookmark: PrintingReportsFromTheMainMenu]Click the Close button () to close the Print Preview window.
Printing Reports from the Main Menu
Before you print from the Main menu, you must select the LEA(s) and the entry screen(s) to be printed. For more information, see the Selecting LEAs and Entry Screens for Printing and Exporting to an ASCII (Text) File Section. Table 19 lists all software reports you can print from the Main menu for each user group. The available reports you can print depend on the software application you are using and the user group selected.

	Available Reports
	County Office
	School District
	Charter School
	County Auditor
	SELPA

	Reports
	Yes
	Yes
	Yes
	Yes
	Yes

	Certificates
	Yes
	Yes
	Yes
	Yes
	Yes

	Blank Certification
	Yes
	Yes
	Yes
	Yes
	Yes

	COE Certification
	Yes
	No
	No
	No
	No

	Certification Exception (County, District, Charter, Auditor, and SELPA)
	Yes
	Yes
	Yes
	Yes
	Yes

	[bookmark: _Ref45939936][bookmark: _Toc382819023]LEA Status Report (Attendance and SELPA)
	Yes
	Yes
	Yes
	No
	No


[bookmark: _Toc499721087]Table 19: Available Software Reports for Printing (by user group)
Table 20 describes each type of printed report.
	Report Type
	Description

	Reports
	Prints data reports for selected LEA(s) (from the top grid) and entry screen(s) (from the Entry Screens grid).

	Certification
	Prints a certification page for selected LEA(s) and entry screens so you can get the proper signatures.

	Blank Certification
	A blank certification page can be printed and sent to an LEA that is not using the software to enter their data but is having their school district, COE, or other governing agency enter it for them. In these cases, the governing agency must send a blank certification page to the lower-level LEA so they may sign the certification page.

	COE Certification
	Prints a single certification page for a selected program that lists the certification number for each LEA in the county that submitted data for that program rather than printing a separate certification page for each LEA.

	Certification Exception
(County, District, Charter, Auditor, and SELPA available from Sub-Menu depending on user group)
	Displays the questions and answers from the Data Modification dialog box that opened when you exported certified data. (See the 
Data Modification Section for more information.) 

	LEA Status Report
(Attendance and SELPA available from Sub-Menu depending on user group)
	Depending on the report selected, displays a report that shows the number of records for each program for which you have data, sorted by LEA.


[bookmark: _Ref45941844][bookmark: _Toc382819024][bookmark: _Toc499721088]Table 20: Principal Apportionment Software Printed Report Descriptions
[bookmark: _Toc373143288][bookmark: _Toc373154430][bookmark: _Toc373143289][bookmark: _Toc373154431][bookmark: _Toc373143290][bookmark: _Toc373154432][bookmark: _Toc373143291][bookmark: _Toc373154433][bookmark: _Toc373143292][bookmark: _Toc373154434][bookmark: _Toc373143293][bookmark: _Toc373154435][bookmark: _Toc373143294][bookmark: _Toc373154436][bookmark: _Toc373143295][bookmark: _Toc373154437][bookmark: _Toc373143296][bookmark: _Toc373154438][bookmark: _Toc373143307][bookmark: _Toc373154449][bookmark: _Toc373143308][bookmark: _Toc373154450][bookmark: _Toc373143309][bookmark: _Toc373154451][bookmark: _Toc373143310][bookmark: _Toc373154452][bookmark: _Toc373143317][bookmark: _Toc373154459][bookmark: _Toc373143318][bookmark: _Toc373154460][bookmark: _Toc373143319][bookmark: _Toc373154461][bookmark: _Toc373143320][bookmark: _Toc373154462][bookmark: _Toc373143323][bookmark: _Toc373154465][bookmark: _Toc373143324][bookmark: _Toc373154466][bookmark: _Toc373143325][bookmark: _Toc373154467]After you print the reports, the Status window displays the success or failure of the printing process. You can save the status report by clicking the Save button, or print the status report by clicking the Print button. Close the Status window by clicking the Close button.
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Principal Apportionment Data Collection

Software used by local educational agencies (LEA) to report pupil attendance, tax, and other data to calculate funding
for the Local Control Funding Formula (LCFF) and Special Education (AB 602).

Principal Apportionment Data Collection Software

Beginning fiscal year 2013-14 Second Principal (P-2) reporting period, LEAS report pupil attendance, tax, and other
data that are used to calculate funding for the LCFF and AB 602 in the Principal Apportionment Data Collection
(PADC) Software. For data reporting prior to 2013-14 P-2, please see the Attendance and Revenue Limit data
collection Web pages.

Note to PADC Software Users: For help with the software and to access the PADC Data Reporting Instruction
Manual (DRIM), select the appropriate fiscal year below and see the Resources and Documentation section.

= PADC Software Fiscal Year 2018-19
PADC Software Fiscal Year 20 8
PADC Software Fiscal Year 2016-17
PADC Software Fiscal Year 2015-16
PADC Software Fiscal Year 2014-15

PADC Software Fiscal Year 2013-14

Questions: Principal Apportionment Section | pase@cde.ca.gov | 916-324-4541
Last Modified: Friday, October 26, 2018
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